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EDICAO 2 RELOADED...

BOM PESSOAL, A SEGUNDA EDIGAO TA A. DEMOROU UM POUCO MAIS DEVIDO A MIGRAGAO DO FORUM DA UNIDEV QUE
RENDEU BOAS DORES DE CABEGA PARA OS ADMINS DA COMUNIDADE. MAS NO FINAL DEU TUDO CERTO E O FORUM NOVO ESTA All
MUITO MELHOR, MENOS BUGS, MAIS SEGURANGA E MUITO MAIS RAPIDO.

QUERIA AGRADECER A TODAS AS PESSOAS QUE DIVULGARAM E COMENTARAM SOBRE A REVISTA, BEM COMO TODAS AS
SUGESTOES E CRITICAS FEITAS. PODEM TER CERTEZA QUE TODAS FORAM MUITO VALIDAS. MAS MUITO MAIS DO QUE CRITICAS E
SUGESTOES, PRECISAMOS DE APOIO NA ORGANIZAGAO DA REVISTA. PECO MAIS UMA VEZ A TODOS QUE QUISEREM COLABORAR
COM, ARTIGOS, TUTORIAIS, COLUNAS QUE ENTREM EM CONTATO COMIGO OU COM O RODRIGO FLAUSINO ATRAVES DOS E-MAILS:
MERKEL.DANIEL@GMAIL.COM E RODRIGOFLAUSINO@YAHOO.COM.BR.

POR FIM QUERIA AGRADECER O PESSOAL QUE COLABOROU COM ESSA EDICAO. SEM A AJUDA DE VOCES, A REVISTA NAO
TERIA SAIDO.

VALEU MESMO!

DANIEL MERKEL

VAMOS DOMINAE O MLINDO!!



ERRATA DA EDICAO 01

PAGINA 3:

O NOME DO USUARIO LORD ETERNAL K FOI GRAFADO ERRADAMENTE. E PAULO DE CAMPOS, E NAO PAULO NASCIMENTO.
O SOBRENOME CORRETO DO USUARIO RODRIGO_FLAUSINO E GALDINO, E NAO GAUDINO.

O NICK DO USUARIO RICARDO RINALDI E RGRDESIGNER, E NAO RGBDESIGNER.

PAGINA 5:

A FICHA DO USUARIO LORD ETERNAL FOI GRAFADA ERRADAMENTE. SEGUE FICHA CORRETA.

NOME: PAULO DE CAMPOS

NICK: LORD ETERNAL K

CIDADE : FLORIANOPOLIS-SC

E-MAIL : LORDETERNAL@LORDETERNAL.COM.BR

AREA DE INTERESSE: 3DS MAX, TGE Z-BRUSH, POSER...

PAGINA 62 A 71

O EMAIL DO USUARIO RGRDESIGNER FOI GRAFADO ERRADAMENTE. O CORRETO E RICARDO.RINALDI@GMAIL.COM
PAGINA 77

O SEGUNDO GAME E THE LEGEND OF ZELDA - TWILIGHT PRINCESS, E NAO THE LEGEND OF ZELDA WIISPORTS - TWILIGHT PRINCESS

VAMOS DOMINAE O MLINDO!!



NOME: BRUNO CROCI

NICK: CROCIDB

CIDADE: GUARULHOS - SP
E-MAIL: CROCIDB@HOTMAIL.COM

AREA DE INTERESSE: PROGRAMAGAO DE JOGOS (C/C++, JAVA) E PROGRAMAGAO WEB (PHP
JAVASCRIPT, FLASH)

NOME: DANIEL S.C. MERKEL

NICK: MERKEL

CIDADE: PASSO FUNDO / SAO LEOPOLDO - RS

E-MAIL: MERKEL.DANIEL@GMAIL.COM / DANIELMERKEL@HOTMAIL.COM (MSN)

AREA DE INTERESSE: PROGRAMAGAO DE JOGOS (C/C++) OPENGL, PROCESSAMENTO DE
IMAGENS, MODELAGEM 3D, 3D STUDIO MAX, WEBDESIGN, DESIGN DIGITAL.

NOME: FERNANDO TONON DE ROSSI

NICK: KILL GUNS

EMAIL: MISTICGORRAM@HO TMAIL.COM

CIDADE: CUIABA - MT

AREA DE INTERESSE: ELETRONICA E DESENVOLVIMENTO DE JOGOS.

NOME: LUIZ FERNANDO ALVES DA SILVA
NICK: ZIZACO
E-MAIL: ZIZACO@GMAIL.COM

HLUMAM... ELES sS40 BONS!
MAS NOSSA EQUIPE E MELHOR!!



NOME: RODRIGO FLAUSINO GALDINO DE LIMA

NICK: RODRIGO_ FLAUSINO

E-MAIL: RODRIGOFLAUSINO@YAHOO.COM.BR

CIDADE: VARGINHA - MG

AREA DE INTERESSE: MODELAGEM 3D, PROGRAMAGAO E GAMEDESIGN

NOME: RAFAEL MORAIS

NICK: FUNKDELIC

CIDADE: SAO PAULO - SP

E-MAIL: FUNKDELIC3D@HO TMAIL.COM
AREA DE INTERESSE: GAME ART

NOME: RICARDO G. RINALDI

NICK: RGRDESIGNER

CIDADE: BETIM - MG

E-MAIL: RICARDO.RINALDI@GMAIL.COM ~

AREA DE INTERESSE: MODELAGEM 3D, ANIMACAO, FX, GAMES.

NOME: YVES NADJARIAN
EMAIL: YVES.NADJARIAN@GMAIL.COM

CIDADE:: SAO PAULO / SP )
AREAS: PROGRAMAGAO DE JOGOS EM DARK BASIC, XNA. PROGRAMAGAO: VB.NET, C#, C/C++

NOME: ISAIAS

HUMM... ELES S40 BONS!
MAS NOSSA EQUIFE E MELHOR!!
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NOME: RAFAEL MORAIS
CIDADE: SAO PAULO - SP
AREA DE INTERESSE: GAME ART | . -1

DESCRIGAO: NINA LOWPOLY

SOFTWARE: 3DS MAX DESCRIGAO: ANAO FERREIRO LOWPOLY
SOFTWARE: 3DS MAX



NOME: DANIEL MERKEL
CIDADE: PASSO FUNDO / SAO LEOPOLDO - RS

DESCRIGAO: HAROLDO (LOW E HIGH) DESCRIGCAO: PUCCA E GAROU
SOFTWARE: 3D STUDIO MAX SOFTWARE: 3D STUDIO MAX




CRIACAO DE NORMAL MAP - PARTE [

POR RAFAEL MORAIS (FUNKDELIC)

Na primeira parte deste mini tutorial, nos vamos ver o processo de criacdo de normal map utilizando
apenas o 3DStudio Max. Vamos criar um modelo lowpoly e um highpoly e extraindo o normal map a
partir da ferramenta 'RENDER TO TEXTURE'.

Chega de papo, vamos la!




CRIACAO DE NORMAL MAP - PARTE [

CONTINUAGAO

1 - Com o software aberto, crie um primitivo qualquer, eu por exemplo, criei um esfera e apenas
diminui um pouco os 'segments' dela, mas sinta-se livre para usar qualquer objeto.

2 - Usando o modificador 'UVW UNWRAP' eu extrai o mapa de UV do meu modelo LOW POLY.
Vocé s6 precisa do mapa do lowpoly pois € nele que o normal map sera ultilizado.

3 - Duplicando a esfera e usando o modificador "Turbosmooth' eu fiz a versdo HighPoly e adicionei
alguns detalhes simples, para uma melhor visualizagdao no resultado do normal map




CRIAQAO DE NORMAL MAP - PARTE I

CONTINUAGAO

1 - Clique sobre o modelo HighPoly, agora use a ferramenta ALIGN para posicionar o modelo High
junto com o Low, de forma que ambos ocupem o mesmo espaco.

2 - Uma vez posicionado, pressione ok para fechar a caixa de dialogo do ALIGN. Agora selecione o
MODELO LOWPOLY e aperte 0 ou va até o menu RENDERING>RENDER TO TEXTURE.

Na primeira vez, vocé pode ficar meio perdido, pois sdo varias opgdes e botdes dentro desse menu,
mas ndo "esquente a cabeca", o que agente vai usar ¢ simples, rapido, e ndo doi tanto assim hehehe :).




CRIAGAO DE NORMAL MAP - PARTE [

CONTINUAGAO
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1 - Com o modelo LOWPOLY selecionado, € com o RENDER TO TEXTURE aberto voce vai clicar

em PROJECTION MAPPING, e em seguida em PICK.
Agora clique no nome correspondente ao seu modelo HIGHPOLY, clique em ADD para adicionar o

modelo HIGHPOLY a projecao.
Agora pode-se notar que foi adicionado um modificador novo, com o nome de PROJECTION, e

também que um "cage" azul ficou em volta de seu objeto.




CRIAQAQ DE NORMAL MAP - PARTE I
CONTINUAGAO

& Add Texiure Elem... ﬁ{'?

linha azul, representa o ‘cage’
do projection modifier, repare
gue ele esta conternande a
esfera corretamente.

1 - O modificador adicionado serve para vocé definir como o modelo HIGHPOLY wvai ser
"representado” pelo LOWPOLY, dentro desse modificador existem opcdes para voce aumentar ou
diminuir a distancia do seu "cage" a melhor forma eh deichar ele o mais proximo possivel € com um
formato nao tanto baguncado.

2 - Agora na aba OUTPUT, clique em ADD > NORMALSMAP, ele vai adicionar na lista 0 mapa a ser
criado, mais a baixo voce pode escolher o tamanho do mapa, escolha também o nome ¢ o local onde
seu mapa vai ser salvo, de preferéncia em algum lugar de facil acesso hehe :)




CRIAGAO DE NORMAL MAP - PARTE [

CONTINUAGAO

Render L rwrap Only | Close

1 - Agora vocé vai clicar em RENDER, caso aparece uma mensagem, apenas ignore e clica em
continue. Vocé vai notar que uma janela apareceu com seu render nela, novamente, ignore este render

pois nao eh o seu normal, € apenas um render normal.

2 - Seu mapa de normal estard salvo no local em que vocé pré-determinou, no meu caso, a area de
trabalho.




CRIAGAO DE NORMAL MAP - PARTE [
CONTINUAGCAO
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1 - Vamos agora aplicar o mapa de normal no seu modelo. Aperte "M" para abrir o MATERIAL
EDITOR, clique na aba MAPS > BUMP e adicione 0 mapa NORMAL BUMP. Dentro do normal
bump, clique no slot correspondente a0 mapa normal e em seguida escolha o mapa BITMAP, agora
adicione o normal que vocé acabou de gerar.

Mude o valor do bump de 30 para 100 para uma melhor visualizacao.




CRIAGAO DE NORMAL MAP - PARTE [
CONTINUAGCAO

1 - PRONTO!

E esse ¢ o resultado final do nosso tutorial, pode ver que a qualidade fica muito boa, pois o render to
texture do max tira um otimo normal map, na minha opinido, melhor que de plug-ins como o Zmapper
do Zbrush.

Espero que este tutorial esteje claro para todos que vao ler.

Na proxima edicao agente vai um pouco mais além e eu vou mostrar como usar o xNormal um
software gratuio e muito potente para criacdo de normais a partir de fotos.

Bom ¢ isso galera!

Qualquer davida pode me mandar um email: funkdelic3d@hotmail.com




ANIMACAO DE SPRITES COM SDL

POR FERNANDO TONON DE ROSSI (KILLGUNS)

Esse tutorial ¢ uma continuagdo do “SDL - Primeiros Passos” apresentado
na 1* edigdo da revista.

Nesse tutorial pretendo ensinar como animar as sprites € como detectar
entradas do mouse.

Pré-requisitos:
Conhecimento basico da linguagem C;
Conhecimento apresentado no tutorial anterior;
Compilador com a biblioteca instalada.

Vamos fazer estrelas e bolas seguirem o mouse e girar ou parar quando clicamos um botdo do
mouse.

Utilizaremos as sprites do site reiner’s tilesets, encontradas no endereco:
http://reinerstileset.4players.de/animatedE.htm.

Carregando as sprites:
O primeiro passo € carregar as sprites, para isso utilizaremos a fun¢gdo SDL_LoadBMP.

SDL_Surface *Estrela Bola[36];
char sprite[20];

for(int m = 0; m < 36; m++)

{
sprintf(sprite,"” groggy00%d.bmp",m);
Estrela_Bola[m] = SDL_LoadBMP (sprite);

}:
Vamos deixar o fundo transparente, o fundo dessas imagens ¢ azul claro (220,239,255).

for(int m = 0; m < 36; m++)

{
SDL_SetColorKey(Estrela Bola[m], SDL_SRCCOLORKEY | SDL_RLEACCEL ,

SDL_MapRGB(Estrela_Bola[m] ->format, 220,239,255));
}:

Verificando a¢des do mouse:

Agora ja temos todas as sprites carregadas, vamos detectar a posi¢do do mouse com a funcao
SDL_GetMouseState.

int X=0,Y=0;
SDL_GetMouseState(&X,&Y);
SDL_Rect rect_imagem;

rect_imagem.x
rect_imagem.y

X3
Y3




ANIMAQ{TO DE SPRITES COM SDL
CONTINUAGAO

Vamos criar uma pilha de eventos para gerenciar os eventos do mouse.

SDL_Event evento;
bool Botao = false;

if(SDL_Pol lEvent(&evento))

{
switch(evento.type)
{
case SDL_MOUSEBUTTONDOWN:
Botao=true;
break;
case SDL_MOUSEBUTTONUP:
Botao=false;
break;
}
}

Imprimindo a animacao:
Ja sabemos a posicao do mouse e qual botdo foi clicado, agora basta fazermos a animacao.

Para isso vamos declarar uma variavel que servira de contador e vai registrar em qual posicao
esta a animagao.

int Anim=0;

Agora vamos aumentar o valor se o0 mouse estiver liberado e ndo aumentar se algum botdo
estiver pressionado.

if(Botao==false)

{
iT(Anim<35)
Anim++;
else
Anim = 0;
}

J& fizemos o controle da animag¢ao, agora vamos imprimi-la na tela e pronto!

SDL_FillRect(Tela, 0, SDL _MapRGB(Tela->format, 0, 0, 0)); // Imprime um
quadrado preto no fundo da tela, isso define a cor do fundo.

SDL_BlitSurface(Estrela Bola[Anim],NULL,Tela,&rect_imagem);
SDL_Flip(Tela);




ANIMAQJO DE SPRITES COM SDL
CONTINUAGAO

Codigo completo utilizado nesse tutorial (continuacao do tutorial apresentado na primeira

edicdo):

#include <SDL.h>

int main(int argc, char** argv)

{

SDL_Init(SDL_INIT_VIDEO|SDL_INIT_AUDIO);

atexit(SDL_Quit);

SDL_Surface *Tela;

Tela = SDL_SetVideoMode(800, 600, 16, SDL_SWSURFACE|SDL_FULLSCREEN);

SDL_Surface *Estrela_Bola[36];
char sprite[20];

for(int m = 0; m < 36; m++)

{
sprintf(sprite,"” groggy00%d.bmp",m);
Estrela_Bola[m] = SDL_LoadBMP (sprite);
}:
for(int m = 0; m < 36; m++)
{
SDL_SetColorKey(Estrela Bola[m], SDL_SRCCOLORKEY | SDL_RLEACCEL ,
SDL_MapRGB(Estrela_Bola[m] ->format, 220,239,255));
}:
int X=0,Y=0;

SDL_GetMouseState(&X,&Y);
SDL_Rect rect_imagem;
rect_imagem.x = X;
rect_imagem.y = Y;

SDL_Event evento;
bool Botao = false;

if ( SDL_PollEvent ( &evento ) )

{
switch(evento.type)
{
case SDL_MOUSEBUTTONDOWN:
Botao=true;
break;
case SDL_MOUSEBUTTONUP:
Botao=false;
break;
}




ANIMA§/~4~O DE SPRITES COM SDL
CONTINUAGAO

}

int Anim=0;

iT( Botao == false)

{
iT(Anim<35)
Anim++;
else
Anim = 0;
}

// Imprime um quadrado preto no fundo da tela, isso define a cor do fundo.
SDL_FillRect(Tela, 0, SDL_MapRGB(Tela->format, 0, 0, 0));

SDL_BlitSurface(Estrela _Bola[Anim],NULL,Tela,&rect_imagem);

SDL_Flip(Tela);
return O;

Referéncias Bibliograficas:

SDL API - SDL Documentation Wiki — Disponivel em:
<http://www.libsdl.org/cgi/docwiki.cgi/SDL_20API> Acesso em: 21/05/2007.

Reiner’s tilesets — Disponivel em: <http://reinerstileset.4players.de/animatedE.htm> Acesso em:
02/06/2007.




PARTICULAS SIMPLES EM ALLEGRO

BRUNO CROCI (CROCIDB)

Ola pessoal, tudo bom? Hoje venho apresentar um tutorial simples de Particulas
com efeito de chuva, em Allegro e C. Com ele € possivel entender o conceito de
particulas, e assim, deixa-las mais sofisticadas para colocar em seu jogo.

Bom, chega de papo e vamos para o que interessa!

Primeiramente precisamos ter uma particula como um objeto, que tem posigao e velocidade, veja a
seguinte estrutura:

/* Estrutura da particula */
typedef struct _tParticle

{

int x, y; // Posicao atual da particula

int vel; // Velocidade com que ela se desloca
}tParticle;

A partir desta estrutura, criamos um vetor de particulas, assim:

/* Vetor de particulas */
tParticle parts[NUM_PARTICLES];

Precisamos também de um bitmap, que conterd a imagem da particula, vocé pode carregar ele de um
arquivo pré-definido, ou fazer ele com o allegro mesmo, eu criei uma funcao que desenha a particula e
retorna o bitmap, veja:

BITMAP* doParticle()

{
/* Cria bitmap */
BITMAP* teste = create bitmap(l, 2);
/* Pinta ele de uma cor */
clear_to_color(teste, makecol (200,200,255));
/* Retorna ele */
return teste;

}

Criei um bitmap global:

/* BITMAP que contem a imagem da particula */
BITMAP *particle;

E entdo desenhei a particula nele:
/* Chama a funcao que desenha a particula */
particle = doParticle();

Agora nos criamos as particulas e damos a elas posicoes aleatorias, veja a funcdo create particle:




PARTICULAS SIMPLES EM ALLEGRO

CONTINUAGAO

void create_particle()

{
/*
* Aqui ele inicia todas as particulas com posicoes
* e velocidade aleatoérias.
*/
for (i = 0; i < NUM_PARTICLES; i++)
{
parts[i]-x = rand() % 640;
parts[i].y = rand() % 480;
parts[i]-vel = (randQ) % 3) + 1;
}
}

Agora vamos dividir os processos das particulas em partes, atualizar suas posi¢des e velocidade e
exibir na tela, update particle() e render particle() respectivamente:

void update_particle()

{
/* Atualiza todas as particulas */
for (i = 0; i < NUM_PARTICLES; i++)
{
parts[i].y += parts[i].vel;
parts[i]-vel = (randQ) % 2) + 1;
if (parts[i].y > 480)
{
parts[i]-x = rand() % 640;
parts[i].y = rand() % 100;
parts[i]-vel = (randQ) % 3) + 1;
}
}
}
void render_particle()
{
/* Exibe-as na tela */
for (i = 0; i < NUM_PARTICLES; i++)
{
draw_sprite(buffer, particle, parts[i].x, parts[i].y);
}
}

No update particle nés incrementamos ao Y de cada particula a sua velocidade atual, se sua posi¢ao
verticalmente for maior que o tamanho da tela, entdo ela ndo aparece mais, ai mandamos ela 14 pra cima,
para poder cair novamente.

E no render particle apenas desenhamos na tela um bitmap particle para cada particula em suas
respectivas posigoes.

A1 basta chamar essas funcdes no loop principal. Veja o exemplo que vem junto com a revista.

Viram como trabalhar com particulas nao ¢ tao dificil? Este exemplo é bem simples, mas apartir dele vocé
pode fazer efeitos de neve, efeitos de sangue, vazamento de agua, bom, use a sua criatividade e
conhecimentos de fisica (para os deslocamentos das particulas).

Qualquer duvida, poste no forum da UniDev! Obrigado.
- '




TUTORIAL PARA SOFTIMAGE [ XSI - CRIANDO UM TAPETE COM HAIR

POR RICARDO G. RINALDI (RGRDESIGNER)

Para criarmos o tapete utilizaremos a ferramenta Hair no intuito de simular suas
fibras. Para tal, utilizaremos um mapa de texturas para os parametros de cores dos
fios.

Antes de qualquer coisa, abra uma nova cena.

- Na Barra de Ferramentas “Model” (tecla de atalho “1”), crie um cubo (Get > Primitive > Polygon
Mesh > Cube);

- Na janela Cube, altere o valor de Length para 1;

- Na Barra de Comandos, em Transform, nos campos referentes a escala, informe os valores 5, 1 ¢ 3
respectivamente para os eixos X, Y e Z — os valores sao referentes as dimensoes do tapete de 5,0 m x
3,0 m x 1,0 m de espessura;

Como um tapete nao pode ter espessura de 1,0 m, temos que realizar uma “extrusao” da face superior
no eixo Y negativo. Faca assim:

- Com a ferramenta de sele¢@o de faces por “raycast” (tecla “U”), selecione a face superior;

- Com a face superior selecionada, utilize o comando de translagdo para o eixo Y de modo que a
espessura do objeto seja bem fina;

- Atribua ao objeto referente ao tapete, a projecao de textura XZ (Get > Property > Texture Projection
> XZ);

- Atribua o material Lambert ao objeto (Get > Material > Lambert);

- Na janela Lambert, atribua uma imagem para Difuse (clique no icone de “tomada” do lado direito das
palhetas de cores de Difuse e escolha Image) — veja a baixo:




TUTORIAL PARA SOFTIMAGE | XSI - CRIANDO UM TAPETE COM HAIR

CONTINUAGAO

- Na janela Image, clique em New > New from File... e
escolha uma figura que se adeque ao tapete;

- Novamente na janela Lambert, clique no icone de
“tomada” do lado direito das palhetas de cores de
Ambient e escolha Clips > Tapete tga;

- Adicione uma Point Light na cena, pouco acima do
objeto referente ao tapete;

O objeto “Tapete” deve se apresentar com o aspecto
semelhante ao da ilustragdo ao lado:

- Alterne para a Barra de Ferramentas “Hair” (teclas
Ctrl + 2);

- Novamente com a face superior do objeto selecionada,
va em Create > Hair > From Selection;

- V4 em Display > Render Hair > Show Render Hair;

- Re-escale o tamanho dos fios (Modify > Scale);

- Na janela Hair, na aba General, altere o valor de Render Settings > Total Hairs para 50000 — caso
tenha fechado a janela, basta pressionar “Enter” com o objeto “Hair” selecionado;

- Ainda na mesma aba, em Hair Multiplicity > Strand multiplier, altere o valor do campo para 2,0;

- Na aba Effects, em Thickness, altere o valor do campo Root para 1,5 e do campo Tip para 0,5;

- Feche a janela Hair;

Temos agora que conectar um mapa de textura aos parametros de cores de Hair.
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CONTINUAGAO

Faca da seguinte forma:
- Selecione o objeto emissor de Hair e va em Get > Property > Texture Map > Texture Map, na Barra
de Ferramentas “Model”;

- Na janela Texture Map, selecione um arquivo de imagem para o mapa da seguinte forma:
- No campo referente a Clip, escolha a imagem referente a textura para o tapete;

- Abra o Explorer e expanda a arvore do objeto emissor de Hair, para que seja localizado o icone

Texture Map; o

- Ainda no Explorer, selecione o objeto emissor de Hair e o objeto

Hair — para selecionar mais de um objeto no Explorer, mantenha a

tecla “Ctrl” pressionada;

- Alterne novamente para a Barra de Ferramentas “Hair” (Ctrl + 2);

- Clique no botao Transfer Map (Modify > Transfer Map);

- No Explorer, clique sobre Texture Map do objeto emissor, como

mostrado ao lado:

- Selecione apenas o objeto Hair;

- Na Barra de Ferramentas “Hair”,

va em Modify > Shader;

- Em Hair Renderer, clique no

icone de “tomada” do lado direito

das palhetas de cores de Ambient

> Color e escolha Clips >

Tapete tga (ou no nome da textura

que vocé esta utilizando) — veja ao

lado:

- Repita o procedimento para

Diffuse > Root Color e para Tip

Colors > Color A e Color B;

- No campo Flat Shading, informe

o valor 15 para Root (%) e 75 para

Tip (%);

Hepir “Lpfiwialdh : Maw Bevalrrer (B eralernrsg )
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- No campo Specular, desmarque a caixinha referente a Enable;

- Na aba Transparency, desabilite Enable;

- Na aba Render Settings, informe o valor 1 para o campo Normal Blend,;

Pronto! A modelagem do tapete esta finalizada.

O aspecto final da modelagem “renderizada” deve se assemelhar com o da figura ilustrada abaixo:

E importante lembrar que o uso da ferramenta Hair deve ser usado com parcimdnia, pois seu uso
acarreta num aumento de pontos a serem levados em conta pelo software e, por sua vez, gera mais
calculos e maior tempo de render.

Uma correta texturizacdo e um uso adequado de Bump Mapping podem substituir o uso de Hair,
dependendo do tipo de exposi¢ao da cena.

O interessante desta aplicacdo ¢ a coloracdo variada de cada fio, ganha gracas ao mapeamento da
textura.
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Fala ai galera! Tudo tranqiiilo? Este ¢ o primeiro tutorial de uma série de artigos que estarei abordando
sobre modelagem e animagao em 3Ds Max 8. Segue abaixo a representagao:

Tutorial 1: Explosdo 3D realista (Combustion);
Tutorial 2: Sistema de particulas;

Tutorial 3: Modificadores;

Tutorial 4: Efeitos especiais;

Para esta edicdo da udzine, preparei um material falando sobre como criar explosdes tridimensionais
realistas no 3ds max. Este efeito pode perfeitamente ser adaptado nos mais diversos projetos, por
exemplo, eu, desenvolvi uma animagao de uma nave espacial explodindo. Vou tentar apresentar de um
modo mais dinamico e simples, para até mesmo quem nunca usou 0 max conseguir acompanhar.

Otimo, vamos 1. Para iniciar, crie um box na Viewports pespective, com as dimensdes e niimeros de
segmentos representado na figura abaixo:

T ii'| d’E‘n| [@| | T | i Parameters. |
o Length:' EO0 ﬂ

o 'k?‘ . 37 i [ 1|
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Clicando com o botdo direito do mouse em pespective, € marcando edge faces vocé tera essa visao do
objeto criado.

Wiews

v Smooth + Highlights
Wireframe
Ckher

v Edged Faces
Transparency

v Show Grid
Shiow Eackground

Showe Safe Frame

Yiewpork Clipping
Texture Carrection
Disable Wiew

Excelente, agora vamos criar a bomba, que serd responsavel por deformar o nosso objeto em pedagos.
V4a ao menu Create, clique Space Warps , selecione Geometric/Deformeble e opte por bomb. Desenhe

a bomb bem no centro de seu box. . .
[e2e® T
oy & o]

I Geometnc/Deformable i

L _ Dbject Type |
AutoGnd T '
FFDBiox] FEDCyN)

W ave ‘Ripple

Dizplace | Conform
| Bomb l
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Bom, para ndo abordarmos assuntos que nao ¢ de nosso interesse, ndo vamos fazer a texturizagdo da
caixa e nem aplicar luzes. Presumo que vocé esteja familiarizado com estes detalhes. Caso contrario,
entre em contato que o ajudarei!

Voltando ao assunto. Agora ¢ necessario linkar a nossa bomba ao nosso objeto criado, certo? Para isso
va ao toolbar superior e clique em bind Bind to space Warp, selecione a bomb e arraste marcando a
caixa. Pronto! A caixa ja sofrerd as agdes da bomb.

File Edit Tools Group Views Create  Modifiers Characker

ot [ et

| '
H {];t:g I _:_1 Bind to Space Warp | O [default]
AB —

III'II||I||
7

Para testa-la, clik em play e veja a explosdo, estas particulas que voam bruscamente, sdo
conseqiiéncias dos numeros de segmentos que deixamos acima 50, 50, 50. Selecione a bomb, e va ao
painel modify, e altere os valores de gravity, chaos, seed, o campo detonation provavelmente estara em
5, ou seja, a explosdo comecara no frame 5, fique a vontade para alterar

h.. LA ' — General
kEd&|[@|@| T| Gravity:l'l,[l—ﬂ

'Cham:'l 0.0 ﬂ
Detu:unatinn:'l R ﬂ
5 eel:l:l 0 ﬂ

Otimo, excelente. Ja temos o controle de nossa explosdo, agora o que nos falta ¢ o fogo para passar a
impressdo de explosao.
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Este efeito ¢ criado com ajuda de um objeto Helper chamado Gismo. Para criar este objeto, va até o
painel de controle selecione Create, depois helper e selecione atmospheric apparatus, € opte por
SphereGismo. Desenhe a SphereGismo de modo que cubra a caixa. O raio dela ¢ muito importante,
pois ela sera responsavel pelos danos

mWIﬂ%I*@IEITI

ED:-:Elzﬁmj
.E_I,I}G IZmo
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Feito isso, temos que habilitar o 3ds max para o fogo ser exibido, vamos entdo até
Rendering/Environment, ou simplesmente tecle 8, adicione Fire Effect, ou seja, o fogo; marque Pink
Gismo, tecle H, e selecione SphereGismoO1, logo mais abaixo, marque a op¢ao explosion, entre em
setup explosion (esta parte ¢ indispensavel) e clique em ok. Desmarcando a op¢do smoke podemos

tirar o efeito de fumaca, lembrando que podemos também alterar a fury da explosdao. Observe a figura
a seguir:

© Environment and Effects

E hvironment | Effects |
Effects:
Fire Effect Add.
Delete
v Active
fove p
Move Down
M ame: | Fire Effect b erge
{- Fire Effect Parameters
— Gizmos:
Pick Gizmo Remove Eién‘u::l Spherelaizrol -
— Calors:

#' Setup Explosion Phase Curve

i Start Time: ID ﬂ 5} |
~ Maoti End Time: [100 - P |

™, |

— Explosion: \"'-.,,.

Iv Explosion Setup Explosion. ..

¥ Smoke Funy: |'|,|:| ﬂ
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Otimo, pressione F9 no frame 15, e vera um bloco se partindo e o fogo o envolvendo...

Agora, se quiser renderizar a animacao com seus 100 frames, (¢ claro que vai querer), entre em Render
Scene Dialog, ou pressione F10. Marque a opcao Active Time Segment, e verifique se as opcdes effets
e Atmospherics estao marcadas.

B2 _Common Parameters |
— Time Output

¢ Single Ewvem Mth Frame: |‘| ﬂ

#® Active Time Segment: 0 Tao 100
£ Range: [0 2 7e 00 1 Z
File Murnber Base: |EI ﬂ

" Frames  |1.3512

4k

— Render Dutput

[T SaveFile Files...

Salve essa animacdo em uma pasta vazia como seqiiéncia de imagens TGA. Agora podera estar se
perguntando: Mas imagens? Queria um video! Calma! Este método tem a vantagem de renderizar tudo
em arquivos de imagens, caso pisque a energia, ou dé qualquer outro problema la no frame 95, vocé
ndo tera que renderizar tudo novamente, ¢ s6 marcar a caixa Range e marcar o frame que quer
renderizar, no caso o frame 95 a 100. Depois de renderizado, abra a pasta e veja um monte de arquivos,
digo, 100 tga. Para criarmos um video dele ¢ simples, vamos usar um programa gratuito e excelente
pra esse tipo de trabalho, o VirtualDub, faca o download. Depois de instalar, abra o programa, va em
file e escolha open video file, escolha o arquivo tga inicial e dé ok.

Para o seu video final ndo ficar muito grande e pesado, va ao menu video e escolha compression,
escolha um codec que lhe agrade, agora ¢ s6 ir ao file e clicar em Salve As AVI, e deixe renderizar por
poucos segundos.
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Pronto, sua explosao ja esta feita!!!
Agora lembre-se, ndo se limita a isso, fique livre pra criar texturas, iluminacdo, um céu, etc’s. Veja
como poderas chegar em um cendrio trabalhado, e claro, consumird um maior tempo de render.




3D GAMESTUDIO - CARTOON SHADER

DANIEL MERKEL (MERKEL.DANIEL@GMAIL.COM)

Para utilizar o efeito cartoon em seus modelos no 3d gamestudio 6.22 (ou superior)
cole o codigo abaixo no seu  arquivo wdl principal e utilize uma imagem

}-IjTﬁhﬁk

semelhante a esta abaixo com o nome de toonlookup.png.

_

Nao esqueca de colocar a acdo "action cartoon" no seu modelo 14 no wed.

action cartoon

{

my.material=mtl_toon;

}

bmap bmp_toonlookup=<toonlookup.png>;

material mtl_toon

{

skinl=bmp_toonlookup;
effect =

matrix matWorldViewProj;
matrix matWorld;vector vecSunDir;
texture entSkinl;texture mtlSkinl;
technique t0{

pass pO // shade it

{

zwriteenable= true;
zenable = true;
Texture[0]=<mtlSkinl>;
ColorOp[0O]=Modulate;
ColorArgl[O]=Texture;
ColorArg2[0]=Texture;
AddressU[0]=Clamp;
AddressV[0]=Clamp;
AddressW[0]=Clamp;
TexCoordIndex[0]=0;
Texture[l]=<entSkinl>;
ColorOp[1]=Modulate;
ColorArgl[1l]=Texture;
ColorArg2[1]=Current;
TexCoordIndex[1]=1;
VertexShaderConstant[O]
VertexShaderConstant[4]
VertexShaderConstant[7]

<matWorldViewProj>;
<matWorld>;
<vecSunDir>;

UTorlals

#
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VertexShader =

{

asm

vs 1 0

dcl_position VO
dcl_normal v3
dcl_texcoordO v7
dcl_texcoordl v8

mov
dp4
dp4
dp4
dp4
dp3
dp3
dp3
dp3
mov

j

oT2.xy, Vv7

oPos.x, c0, vO

oPos.y, c1, vO

oPos.z, c2, vO

oPos.w, c3, VO

rOo.x, c4.xyz, v3.xyz
rOo.y, c5.xyz, v3.xyz
rO.z, c6.xyz, v3.xyz
oT0.x, rO.xyz, -Cc7.xyz
oTl.xyz, v8

pass pl // ink it

CULLMODE=CW;
vertexShaderConstant[O]=<matWorldViewProj>;
vertexShaderConstant[16]=0.8; // grossura

contorno

vertexShader = asm

{

vs 1 0

dcl_position vO
dcl_normal v3
dcl_texcoord v7

mov r0,vO

mul rl,cl6.x,v3

// Scale the normal

add rO.xyz,r0O.xyz,rl.xyz
m4x4 oPos,r0,cO

// Transorm position to clip space
mov oDO, cO

mov r0,cO

Torlals

55

do




COMO FAZER UM PROJETO REAL

POR LUIZ FERNANDO ALVES DA SILVA (ZIZACO).

Muita gente deve achar esse artigo algo
totalmente desnecessario. Pra alguns pode ate
ser, mas algo que ja presenciei muitas vezes ¢
algum projeto em desenvolvimento sendo
abandonado, descontinuado ou simplesmente
esquecido.

Aqui vai uma coletanea de dicas sobre
como manter seu projeto (ou futuro projeto) em
constante desenvolvimento e como torna-lo
possivel.

Romance e Realidade

Essa ¢ a primeira coisa que condena
qualquer projeto! Antes mesmo de comegar o
projeto voc€ ja pode constatar que ele vai
morrer.

Vou explicar a teoria com base a um
evento literario:

O Romantismo

Na literatura  brazileira(sim, sou
antipatriota ;D) os artistas escreviam em um
estilo chamado "Romantismo", aonde tudo era
lindo e maravilhoso! Romances prometidos e
finais felizes. Tudo um mar de rosas.

Na literatura romantismo as coisas eram
perfeitas como deveriam ser, os personagens
das historias literarios ndo tinham defeitos,

eram herdicos e puros, alem
de que tudo sempre acabava
bem no final. O mundo era perfeito, pacifico,
todas as pessoas do mundo sdo boas e querem o
bem estar coletivo.

ApoOs varios anos, percebeu-se de que o
romantismo nao passava de conto-de-fadas
aonde coisas totalmente irreais e incabiveis
aconteciam.

Voltando ao mundo dos games. Sim,
isso se reflete nos games!

Muita gente vive no romantismo da
coisa, acreditam que podem fazer jogos
perfeitos, revolucionarios e inimaginaveis! Que
mesmo sem ter terminado nem um jogo se quer
e mesmo tendo minima experiéncia, acreditam
que podem criar um jogo da ultima geracao!
Acham que vao terminar seus jogos em pouco
tempo, ou pior, acham que vao terminar em 7
anos, mas acreditam fielmente que vai valer a
pena pois sera "o melhor jogo do mundo".

Outro pensamento extremamente
romancista ¢ o de criar um MMORPG(Mult
Massive On-line RPG, ou simplesmente RPG-
Online!). Eu confesso que ¢ muito triste vocé
ver uma equipe, ou pior ainda, uma pessoa
apenas, iniciando um projeto de um RPG On-
line Massivo. Isso ¢ o extremo do romantismo.
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Agora vem a parte chata de tudo isso: O
Romantismo ndo é bom! Pelo contrario, ¢é
péssimo!

Assim como um conto de fadas, o
romantismo ¢ algo irreal, inatingivel,
inexistente. E triste pra vocé, pra mim, e pra
todos os desenvolvedores de jogos que nao
trabalham numa empresa especializada com
equipe, dinheiro, e experiéncia no mercado.

O Realismo

A evolucao literaria do romantismo foi o
"Realismo".

No realismo, as coisas eram reais do dia
dia de uma pessoa comum.

Na literatura realista as coisas ndo sdo
perfeitas, os personagens tem defeitos, muitas
vezes eram covardes, e nem sempre o final ¢
feliz. O mundo ndo ¢ perfeito, as pessoas nao
sdo todas boazinhas, existe corrupcdo, bandidos
e tudo que ¢ Real. Logico que também existiam
coisas boas mas ndao em exagero, como no ja
morto romantismo.

Voltando ao mundo dos games, mais
uma vez.

Existem muitas pessoas(a maioria) que
ndo admitem o realismo, justamente por ele ser
a triste verdade, mas sim:

Vocé ndo vai fazer um jogo perfeito,
nem revolucionario, nem algo inimaginavel.
Seu jogo ndo vai ter os ultimos recursos
graficos nem de nucleo. Vocé ndo vai termina-
lo em um piscar de olhos e muito menos vai
agiientar 7 anos trabalhando nele pra ele sair
extraordinario.

E muito menos sera um RPG On-line
massivo! Caia na real!

Achou ruim? Agradeca se vocé terminar
seu jogo. Porque nem isso o0s romancistas
conseguem!

Fatos Realistas

A chave para finalizar um projeto de
jogo € ndo ser romantico quanto ao que vocé
pretende fazer. Nao imagine um super-jogo
aonde o jogador pode fazer tudo que quiser, ou
um jogo graficamente 6timo.

Agora como praticamente todos os
romancistas ndo aceitam o realistas, vou ter o
dificil trabalho de mostrar o quanto eles estdao
errados. Logico que eu ndo vou convencer
ninguém, mas nao vao dizer que eu ndo tentei.

Analise os fatos a seguir:
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* Nunca nenhum jogo do brazil teve
nivel de um jogo do exterior, principalmente se
feito por alguma empresa. E ndo, o seu ndo vai
ser o primeiro! Caia na real!

* Se vocé tem contato com alguma
comunidade de desenvolvedores de jogos, vocé
constatara que: Todo mundo fala que sabe, mas
ninguém nunca terminou um projeto.

* Se vocé tem contato com alguma
comunidade de desenvolvedores de jogos, vocé
constatara que: Todo mundo fala que vai fazer
um jogo, mas nunca ninguém faz.

* Se vocé tem contato com alguma
comunidade de desenvolvedores de jogos, vocé
constatara que: Apesar dos fatos acima, muita
gente comeca projetos, mas sempre abandonam.
Pode ver que depois de um tempo eles param de
atualizar sobre informagdes sobre os projetos, €
depois ninguém nem lembra mais!

* Existem centenas desenvolvedores de
jogos no brazil, mas existem poucas dezenas de
jogos que foram produzidos aqui.

* Se vocé for examinar essas poucas
dezenas observe que que todos sdo jogos
simples, simples do tipo que um romancista
acharia "bobo"

* Se vocé for examinar essas poucas
dezenas de jogos que foram concluidos,

constara que metade deles tiveram algum lucro
consideravel

* Vocé€ pode contar nos dedos da mao
quantos jogos foram feitos com "super-engines"
gratuitas como Ogre

* Vocé€ pode contar nos dedos do
cotovelo(zero) quantos jogos foram feitos com
"super-engines" gratuitas como Ogre no brazil.

* Desses poucos jogos que foram
concluidos praticamente nenhum foi feito por
uma pessoa so.

* Desses poucos jogos que foram
concluidos praticamente todos foram
renumerados e tiveram um investimento inicial
que saiu do bolso de alguém.

* Nao, esse alguém ndo foi o ministério
da cultura brazileiro. Caia na real!

* Vocé mora no brazil

Se isso ndo foi o bastante pra voce. Pare
de ler esse artigo, continue por nunca terminar
seus projetos, e continue iniciando um novo
projeto por més ou semana, afinal vocé ¢
brazileiro e ndo desiste nunca!
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Iniciando um projeto

Se vocé percebeu que nao adianta viver nos
contos-de-fadas romancistas de fazer um super-
jogo. Aqui vao dicas de como iniciar um projeto
serio e real.

O jogo sera grafico?

Um jogo grafico ¢ qualquer jogo que possua
imagens em movimento(sejam 2D ou 3D),
varios modelos 3D ou varias sprites 2D. Se sim,
vocé precisara de alguém para cuidar dessa
parte, ¢ dependendo do nivel grafico, vocé
precisara de uma equipe para isso. Exemplos:
de jogos ndo graficos sao o Civilization 2 ou -,
Um jogo de tabuleiro, Um jogo de estratégia
que nao seja em tempo real, Um tetris, Um
adventure ao estilo CarmenSanDiego, etc...
(todos bobos pra um romancista, apesar de que
eles nunca fizeram nem um desses.)

Tente evitar niveis graficos exagerados. Isso ¢
uma coisa que condena a maioria dos projetos.
Saiba que existem outras maneiras de deixar um
jogo interessante e atrativo.

Todos os exemplos citados de jogos nao
graficos, sdo de extremo sucesso e geraram
muito mais lucro do que "Sandy & Junior O
Game"(Um jogo grafico produzidos no brazil).
Agora se vocé ¢ do tipo "a unica coisa que
deixa um jogo bom ¢ o grafico" desista de
desenvolver jogos, principalmente no brazil.

O Sistema de Jogo

O que vocé pode fazer no jogo final? Pense em
coisas simples, porem divertidas, os jogos da
serie "Tycoon" por exemplo. Muito cuidado
nessa parte, cuidado para ndo voar alto de
mais(ser romancista). Um jogo com a liberdade
do "GTA: SanAndreas" ¢ algo ndo muito
realista.

E muito importante que vocé faca um bom
Design de jogo, uma documentacdo que
contenha tudo que vocé pode fazer no jogo,
como as coisas reagirdo, etc.

Eu publiquei um artigo
(http://zizaco.wordpress.com/tutoriais/design-
document/) sobre como fazer um bom design
de jogo, se voc€ quiser dar uma boa lida ajuda
bastante, mas lembre-se de manter sempre os
pés no chdo, e ser realista, principalmente por
que o design de jogo influi diretamente nas
ferramentas que vocé ira usar para desenvolve-
lo.

Um jogo com muitas possibilidades, escolhas,
capacidades e recursos de qualquer tipo,
requerera uma engine ou linguagem mais
potente, o que cai em outro buraco romancista.



COMO FAZER UM PROJETO REAL

CONTINUAGAO

Dependendo das possibilidades do jogo vocé
precisara de mais de um programador para a sua
equipe.

Ferramentas e Softwares

Aqui ¢ um ponto muito importante! Examine
bem o seu Design, e veja quais ferramentas
voceé ira desenvolver o projeto.

Escolha a ferramenta mais simples o possivel
dentro daquilo que vocé precisa.

Evite sempre que possivel super-engines! sejam
elas gratuitas ou ndo. Examine que todos os
jogos que foram completos em super-engines
alem de terem equipes muito numerosas, eram
renumerados. alem de serem de fora do brazil.
Tenha sempre em mente que o que vale ¢ o
produto final, ndo importando as ferramentas no
processo de criacdo. Nao sinta vergonha de ndo
usar uma linguagem de baixo nivel ou uma
super-engine em seu projeto! Tenha em mente
que quanto mais poderosa, mais complicada de
se usar. Portanto querer usar uma engine muito
poderosa ¢ uma atitude romancista.

Formando a Equipe

Se seu projeto se adequou em alguma parte que
mencionou que voc€ vai precisar de uma
equipe, isso vai ser muito importante pra voceé.
Agora se o seu projeto for algo mais simples, ou
ndo grafico, nem sempre uma equipe ¢€

necessaria.

Formar uma equipe nao ¢ uma tarefa facil,
muitos pensam que ¢ s6 convidar alguém que
entenda do assunto, que ira fazer tudo pra vocé
como um escravo, a troca de nada. O que ¢ um
completo engano!

Primeira coisa a saber: Ninguém ira se juntar a
sua equipe a troca de nada, isso mesmo,
ninguém! Vocé tem que necessariamente ter
algo a oferecer(ndo necessariamente dinheiro),
seja a curto ou a longo prazo.

Uma das coisas mais garantidas para atrair
alguém para sua equipe ¢ dinheiro (Ldgico!),
mas como vocé € um brazileiro, vocé com
certeza ira tentar oferecer alguma outra coisa no
lugar de dinheiro. Entdo eu recomendo vocé a
oferecer uma boa proposta. Sim, isso mesmo,
uma boa proposta convence qualquer um. Um
bom projeto de jogo, organizado, com um bom
design, com uma historia legal e realista. Isso ¢
o suficiente para vocé€ conseguir formar sua
equipe, mas a sua proposta tem que ser boa,
bem apresentada, vocé tem que explicar
detalhadamente como vocé pretende que seja o
funcionamento do jogo, dizer quais sdo seus
planos para comercializa-lo depois de pronto
(se vocé for comercializa-lo). Mostre que ¢ um
projeto serio, isso € o mais importante, pois
ninguém(serio) vai querer fazer parte de uma
equipe cuja a proposta seja:



COMO FAZER UM PROJETO REAL

CONTINUAGAO

"Quero fazer um jogo de tiro, vai ser muito
legal, preciso de modeladores, e desenhistas.
Nado € renumerado, dividiremos os lucros
quando o jogo ficar pronto."

Alem de isso ser patético, provavelmente a
pessoa que faz uma proposta dessas ¢ mais um
romancista que ndo deve ter nenhum design do
projeto para mostrar em sua proposta.

Outra coisa importante ¢ analisar as pessoas que
gostaram da sua proposta e querem fazer parte
da equipe. Pois por mais que pareca que
"quanto mais melhor", as coisas ndo sdo bem
assim. Existem muitas pessoas que nao levam
um projeto a serio, entram em uma equipe por
"embalo" e depois simplesmente abandonam ou
esquecem dela. Ao fazer a proposta deixe bem
claro de que ¢ um projeto serio, € que a equipe
deve agir de acordo.

Outra coisa ¢ que existem muitas pessoas que se
acham  qualificadas para exercer uma
determinada tarefa (principalmente
modeladores 3D) quando na verdade nao sdo
muito experientes, e acabam por atrasar todo o
projeto. Selecione bem as pessoas, saiba que
ninguém precisa ser um "expert", afinal voceés
sdao realistas(tomara) e ndo querem fazer um
super-jogo romancista, mas as pessoas precisam
no minimo saber a respeito da atividade que
estdo exercendo.

Apos a sua equipe formada, faca reunides

regularmente, mantenha sempre a comunicacao
e sempre informe todos de cada progresso do
projeto detalhadamente. Afinal sem eles o
projeto ndo anda e a motivacdo deles ¢ ver o
projeto indo para frente.

Recompensa

Isso ¢ o que garante que o seu projeto continue
andando.

Vocé e toda a sua equipe(se vocé tiver uma)
precisam de uma recompensa, logico, afinal
vocé ¢ um ser humano! Mas ndo entenda mal,
quando eu digo recompensa ndo quis dizer
dinheiro em especifico.

Dinheiro ¢ sim uma recompensa, mas ndo a
Unica existente, existe também a gratificacdo
desde ver o personagem que vocé modelou em
acdo no jogo, ate ouvir usudrios e\ou jogadores
dizendo que acharam o seu jogo legal.

Uma boa idéia ¢ expor o progresso do seu
projeto para um  publico de outros
desenvolvedores de jogos ou de jogadores, de
forma que eles possam fazer comentérios, tanto
negativos como positivos. Isso ¢ bastante
motivante para todos da equipe. Afinal ver que
0s usuarios se preocupam com o produto final
(fazendo criticas) ou elogiando as coisas boas
do projeto, faz vocé ndo se sentir sozinho e
ajuda muito te motivando.
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Talvez comentéarios sejam uma das melhores
recompensas, sO ficando atrds para um usudrio
final dizendo o quanto gostou de ter
comprado\jogado o seu jogo, mas ¢ logico que
vocé sO vai ouvir isso se vocé tiver no minimo
terminado seu jogo ou distribuido uma
demonstragado, durante a producdo do jogo, vocé
estara limitado a mostrar como anda o
progresso € o que ja esta pronto.

Consideracoes Finais

Bem acho que ¢ isso.

Se vocé era um romancista, espero que vocé
tenha revisto seus conceitos. Se ndo era, tomara
que esse artigo tenha ajudado em algo.

Muito importante ressaltar que esse artigo foi
inscrito em cima de algumas idéias pessoais
minhas, vocé ndo ¢ obrigado a concordar em
nada que foi escrito aqui.

Esse artigo foi baseado na matéria Ant-
Engavetamento escrita por Luan dos Santos
(http://pandadev.wordpress.com/2007/06/20/arti
go-anti-engavetamento/)




CONCEITOS 3D

YVES NADJARIAN

Resolvi escrever este arquivo antes de comegar a escrever sobre programacao em Dark Basic pois
pude constatar a dificuldade de pessoas em lidar com as trés dimensdes sem poder vé-las. Entdo vou
comegcar com o basico do 3D, que poderd servir para modeladores iniciantes também.

Em minha aula de computacao grafica, foi passado rapidamente para os alunos como funcionam os
famos eixos X, Y e Z, e como o desenho em trés dimensdes ¢ feito baseado neles. E tivemos que fazer
um exercicio em um programa de rasterizacao através de comandos.

O programa era um editor de texto e os comandos parecidos com C/C++ eram digitados para criar
objetos, luzes, cameras, etc. Claro que os que ja conheciam algo do tipo, ou ja haviam modelado,
mesmo que visualmente como no Blender, consegue ter uma visao melhor do espago quando se trata
apenas de variaveis.

Cheguei a esbocar uma grade que representava trés dimensdes para tentar mostrar a alguns colegas
como tudo funciona. E aqui vamos nos.

O bom e velho plano cartesiano
A grande maioria de nds chegou a estudar o famoso plano cartesiano. E a partir dele que temos uma

idéia de como se posicionam objetos no espaco 2D, e mais a frente 3D.
Ele ¢ representado normalmente pelo seguinte desenho:
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O eixo X, ¢ usado para posicionamento horizontal, enquanto o eixo Y usado para posicionamento
vertical. E € muito importante lembrar isso. Muitas pessoas confundem como que o plano cartesiano ¢
desenhado, pensando que estao vendo o plano por cima, quando na verdade a visao € pela frente.

Entdo imagine: se no plano junto ao eixo X, for colocado um objeto qualquer, significa que o objeto
esta tocando o chdo. E ao move-lo pelo eixo Y, vocé estaria tirando o objeto do chao e fazendo-o
flutuar. Alguns confundem o plano achando que seria algo como um tabuleiro de xadrés, movendo o
objeto pela profundidade.

E ¢ ai que entra nosso terceiro eixo, o Z. E ¢é ai que a diversdao comeca. Lembre de jogos como Street
Fighter 2 por exemplo. Ao aplicar um soco em um personagem, bastasse que o soco alcancasse o outro
personagem, nao importava se ao invés de pegar na cara, o soco fosse mal calculado e pegasse
somente de raspao ao lado do rosto. Nao havia a profundidade!

O Mario somente podia passar pelos inimigos pulando por eles. Porque nao apenas dando um passo
pro lado?

Com os jogos 3D, isso mudou, e para isso agregamos ao plano cartesiano o eixo Z:
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Entdo objetos agora possuem 3 variaveis de posicionamento, ndo somente duas. Porém com a vinda do
terceiro eixo, chegou também outros componentes que ndo devem ser desprezados.

Embora no comeco, tais itens nao existissem nos jogos em 3D, se hoje um jogo ndo possui-los, nao
tera a menor qualidade!

Luzes

O conceito de luzes em ambientes 3D para os jogos foi inicialmente para que aquela sombra igual para
todos personagens em forma de circulo pudesse melhorar. Embora calcular sombras requer um bom
esforco do processador (se vocé ¢ iniciante nesta area saiba que nao sao tudo flores, devemos nos
preocupar com performance) e eu ja tenha vistos jogos em 3D com as mesmas sombras em formas de
circulo embaixo dos personagens, esta idéia foi aproveitada para outros usos (também na area de
modelagem).

Pare para pensar. Na verdade nés nao vemos a luz. Nunca passou por sua cabeca que nos filmes
espaciais em que o Sol aparece, ndés vemos o Sol, e também a Terra sendo iluminada por ele. Mas nao
vemos a Luz passando e fazendo o seu caminho até a Terra. A luz s6 ¢ percebida quando ¢ refletida
pelos objetos que estdo em seu caminho. Por isso que ndo adianta apontar uma lanterna pro céu, vai
continuar tudo escuro, pois nada esta refletindo a luz.

Em um mundo 3D acontece da mesma forma, e com isso se tira alguns proveitos, por exemplo, se vocé
fez o terreno todo com belas texturas que teve muito trabalho de criar, e quer que o terreno pareca estar
a tarde, ou a noite, ndo precisa ser refeito, e colocar outras texturas com outras cores. Aplique a luzes
de forma e cor correta que os efeitos serdo os mesmos.

Claro que existem outros usos para luzes em 3D, mas isso ja elimina as davidas de pessoas que nao
faziam a menor idéia do que se tratava. E principalmente: "Porque ndo estou vendo a minha luz?"
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Camera

Ja que a profundidade sera usada, alguns conceitos mudam de quando os jogos eram apenas em 2D.
Lembre-se de jogos de corrida 2D, que até tentavam imitar pistas 3D. Na verdade o que acontecia era
que o carro estava sempre no mesmo lugar, e o fundo se movia para dar a impressao de que o carro
estava andando pela pista.

Em um jogo 3D, imagine ficar calculando as possiveis varidveis de uma pista em 3 dimensdes...
Portanto o que ocorre, a pista ndo se move fica parada, como na vida real. Quem se move € o carro,
como na vida real. E porque vocé sempre v€ o carro? Porque existe uma camera seguindo-o como se
fosse em uma corrida na vida real!

A camera, se bem usada, pode ter efeitos 6timos nos jogos. Caso vocé ja tenha jogado Need for Speed,
deve-se lembrar de quando o carro pulava o tempo ficava mais lento e ele era visto meio que de frente.
Na verdade a camera que estava atras do carro pula para outra posi¢do e mostra o carro de outro
angulo. Coisa que seria praticamente impossivel se ao invés de usar cameras, ficassemos rotacionando
os objetos.

Pense na camera como uma de verdade em um filme, onde os objetos ndo se preocupam em como
aparecerao, ¢ sim a camera que escolhe o angulo.

Acao!

Agora que uma visao do mundo 3D no escuro esta mais facil, estamos prontos para o proximo passo.
Um passo por vez. Elaborarei os proximos artigos a fim de produzir a principio pequenos jogos em
Dark Basic, claro que a logica do jogo ¢ algo que sera adquirido junto, mesmo que sua linguagem
preferida seja outra.

Até a proxima,

Yves Nadjarian



NEM HITLER AGUENTA MAIS

POR YVES NADJARIAN (YN).

Nao ¢ de hoje que ja se comenta sobre
0S jogos que possuem como tema a segunda
guerra mundial estdo saturados no mercado. As
mesmas armas, 0os mesmos gritos dos alemaes, e
nenhuma novidade.

Alias, ndo ha novidades. Tudo sobre este
tema ja foi abordado, do Dia D, ao fim da
guerra. Tenho que assumir, a primeira vez que
vi Medal of Honor: Frontlne em um
Playstation 2, justamente sobre o Dia D, fiquei
abismado com a qualidade, ¢ a melhora na
guerra.

Os jogos de guerra de Playstation One
era apenas voc€ de seu pais contra o exército
inteiro do oponente que estranhamente mandava
somente grupos de 5 ou 6 soldados por vez.
Ora, aquilo ndo era uma guerra era treinamento,
e de escoteiro ainda! E para tentar encobrir isto
os produtores tentavam por um pouco de humor
quando um inimigo ou outro era pego de
surpresa urinando em um poste.

Com o novo console a gama de efeitos
aumentou, explosoes, barcos, avides, mas parou
por ai. Nao ha muito mais o que criar depois
disso.

Uma nova missdo, ou um cenario um
pouco diferente ja ndo compensa mais para
outro jogo abordando o mesmo tema.

Talvez as produtoras resistam e lancem

mais jogos ainda para os novos consoles como
Playstation 3, Wii e Xbox 360, mas acredito
que dificilmente um jogo neste estilo fara
sucesso a longo prazo.

Todos vibraram com os primeiros jogos
neste estilo. Poder reviver um pouco de uma
guerra que tantos ouvimos falar, mas devem
existir mais de vinte titulos. Todos parecidos!

Se Adolf soubesse que depois da guerra
tanta programacdo envolvesse um tema tao
familiar ele cobraria royalties!





